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Introduction
The ACT! synchronization architecture is designed with a high degree of performance,

scalability, and data integrity in mind. The ACT! sync model is a custom implementation that

takes the best of many available Relational Database Management Systems (RDBMS) and third-

party sync products, rolling them into a single dynamic solution tailored specifically to the ACT!

environment and business rules. This architecture supports both desktop database sync as well

as Handheld Device sync with Palm OS® and Pocket PC devices. 

The implemented architecture is a combination of client-side Microsoft® .Net managed code

embedded within the ACT! Framework, as well as server-side Microsoft® SQL ServerTM procedural

objects residing within the ACT! database. The approach leverages the underlying client-server

technologies, allowing more data and process-intensive operations to be handled server-side while

the client-side components define the business logic, data packaging, encryption, and data transport.

The purpose of this White Paper is to provide a general overview of the ACT! sync model,

including a description of the many key features, abilities, and concepts. This document is

directed at both current users, as well as potential new customers seeking to perform a

functional and technical evaluation of the product. Diagrams and examples will be provided

where appropriate, and we will go into greater detail on Internet Synchronization, focusing on

the aspects of setup and configuration.

ACT! Synchronization Overview
ACT! synchronization was remodeled with the ACT! 2005 platform and differs vastly from

versions prior to ACT! 2005. The ACT! synchronization experience mirrors the workgroup

experience as much as possible and is a database to database process, not a user to user

process as in prior versions. It adheres to a Publisher-Subscriber model, meaning that there is

one central Publisher that has one or many remote Subscribers. This collection of databases is

referred to as a “Sync Family.” All remote Subscribers will be true subsets of the contents of the

Publisher database. Peer-to-peer synchronization, which existed in earlier versions, has been

replaced. It is important to note that handheld synchronization (Palm OS, Pocket PC) is

supported from any and all nodes – Publisher or Subscriber.

In an ACT! synchronization environment, there will always be one main database that syncs

with multiple remote databases. Setup for the synchronization process is centralized at the main

database. Once it has been set up at the Publisher database, synchronization will be a “pull”

process initiated by a Subscriber database. The Publisher database, aided by a synchronization

service, will be listening for incoming “pulls” from Subscriber databases. 

ACT! synchronization is dependent on a LAN, Internet, or WAN connection and requires a Sync

Server or service. It is designed as a background process that allows for normal use of both the

Publisher and Subscriber databases during the synchronization process.

As for Subscriber databases, they have responsibility to initiate synchronization on a regular

basis. This ability is set to expire after a certain period of inactivity. This period is defined during

synchronization setup, but can also be changed later on. A Subscriber database may ‘estrange’
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itself from a synchronization relationship with its Publisher database either manually or implicitly

by an Administrator allowing one last sync. Once estranged, it will not be able to re-establish

the relationship. If re-establishment of this synchronization relationship is desired, the Subscriber

needs to be recreated from the Publisher database. 

Goals and Objectives of the ACT! 
Synchronization Model
The overarching goal of the ACT! synchronization model is to provide a highly reliable sync

solution that addresses the key sync scenarios a typical customer may face. 

Other objectives include:

■ Emphasize control of data transport and data resolution

■ Provide clear, consistent behavior 

■ Design for scalability

■ Match sync environment as closely as possible to behavior of “real-time” workgroup scenario

■ Enforce security across all databases

■ Avoid “anonymous subscribers”

ACT! Sync is based upon a Publisher/Subscriber Model:

■ Publisher provides the data

■ Subscriber requests data, retrieves data, and submits new data

■ The “Main” database is the Publisher

■ A “Remote” database is a Subscriber

■ A Main database can have many Remote databases

■ Remote databases have only one Main database

■ A Remote database can also be a Publisher if one or more handheld devices are registered to

that Remote

Methods of Sync
There are three possible Sync Servers available in ACT! by Sage Premium for Workgroups (only

one is available in ACT!). The Sync Server is the middle-tier component that serves as the

“transport broker” and communication mechanism between a Subscriber and Publisher

database. Quite often, users run a Sync Server on the same machine hosting the Publisher

database, but this is not necessary. It is generally recommended that administrators run a Sync

Server on one or more machines other than the machine hosting the Publisher database to

redistribute part of the workload. This can serve to “load balance” the network. It can also

provide a good contingency or failover plan for remote users should connectivity be unavailable

for one of the Sync Servers (i.e. traffic can be re-routed).
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Additionally, with ACT! Premium for Workgroups, recommended practice is to install the

Network Sync Server (and possibly the Internet Sync Server as well) on each client machine that

may receive a Subscriber syncing database. The service can be defined to be a Sync Listener for

the Publisher server/database as well. In the event the prescribed Sync Server in the corporate

office is down or otherwise unavailable, the remote user can start the local Network Sync

Server and change his/her local connection information (on the Sync Panel inside of ACT!) to

“point to” the local machine and port of the local running Network Sync Server.

Specifications of the three possible Sync Servers:

■ Application Sync

• Requires ACT! to be running and Publisher database open, “listening” for incoming syncs

• One “listener” at a time per machine

• Multiple Subscriber databases are able to sync in parallel

■ Network Sync Service (Premium tier only)

• Separate executable run as a service class program

• “Listens” automatically for incoming syncs

• Publisher database may be closed, i.e. ACT! doesn’t have to be running

• Can “listen” for multiple servers and databases

• Multiple Subscriber databases are able to sync in parallel

■ Internet Sync (Premium tier only)

• Uses Microsoft IIS 

• Separate executable run as a service class program

• “Listens” automatically for incoming syncs

• Publisher database may be closed, ACT! doesn’t have to be running

• Can “listen” for multiple servers and databases

• Multiple Subscriber databases are able to sync in parallel

As noted earlier, each Subscriber database can choose its sync method and connection

information. This ability ensures the Sync Family relationships and users to react to growing and

changing conditions dynamically as they arise.

Given the three-tier architecture of the Sync Server, a variety of configurations can be

established within an organization to meet the business and network needs. The following

diagram depicts an ACT! Premium for Workgroups setup utilizing all three Sync Server types

(Application, Network, and Internet). It’s particularly noteworthy that the Network Sync Server

can be configured and run on a Subscriber client itself, communicating with the Publisher

database. With both Network and Internet Sync Server, the service can actually be installed and

run on the Subscriber client, the Publisher server, or a third independent machine hosting

neither of the syncing databases.
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Sync Servers configuration example:

What Is Synchronized
The easiest way to think about what is synchronized is to realize that any one Subscriber

database is a true subset of the Publisher database. Actions taken upon any/all data are always

synced back to the Subscriber’s Publisher database so that nothing “falls thru the cracks” and is

perceived lost. Given this, the following items are synchronized:

■ The synchronization set (Sync Set) of data (as defined below).

■ User and Team data. These access and security-related tables will be identical in all

nodes/members of the Sync Family. The benefit is that security will be consistent across all nodes.

■ Attachments. Attachments related to the Contacts in the synchronization set (as well as

Groups and Companies) may be synchronized, but there may be limits to these attachments

syncing as determined by the options chosen at the time of Subscriber database creation.

There are a number of customizable settings. 

■ Database supplemental files. Database supplemental files (templates, queries, layouts,

macros) can be created at the Subscriber database and they may or may not be synchronized

depending upon options chosen at the time of Subscriber database creation.

■ Schema modifications. Schema modifications are centralized, and may only be done on

the Publisher database and synchronize to each of the Subscriber databases.

■ Picklist modifications. Picklist modifications may be made at any node and will synchronize.

Once a database has been Sync-enabled (whether a Subscriber or Publisher database), ACT!

detects this fact upon database logon and invokes a Sync “File Watcher” on the database’s
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Datastore (a.k.a. Supplemental Files) folder structure. This is true whether the copy of ACT! is

running on the machine hosting the database or another network client machine. This process

ensures that any changes made to any database-related file are recorded in the sync transaction

logs and can therefore be evaluated for sync. It’s important to note that file modifications made

outside of ACT! will potentially be captured as well as normal ACT! operations. The File Watcher

includes both database-specific files, such as Layouts and Templates, and content-specific files

such as attachments.

Features and Capabilities of ACT! Synchronization
Within the ACT! sync feature, a number of usability, performance, security, reliability, and

scalability factors were considered. The following set of features was incorporated into the

product to support those factors:

■ Subscribers can recover from a broken or incomplete sync.

■ Publisher and/or Subscriber can recover from a restored database. This is referred to as “replay.”

■ Automatic Recovery

• “Picks-up” incomplete synchronization sessions – will only resend non-completed

transactions skipping those previously completed for efficiency.

• Solid tool for recovering from dropped connections.

• Verifies that “last sync” date/time agree; if not, previous updates are re-sent.

■ Orphaned (i.e., severed) Subscribers can become Publishers.

■ Subscribers allow only remote Users to login (the Sync Set “who list”).

■ Remote users can manage Subscriptions on either Publisher or Subscriber (“data fishing”).

■ Transactions logged by and stored in the Database (self-contained) – SQL trigger-based.

■ 64-bit DES encryption out of the box. This is configurable and can be disabled via the

application config file.

■ Data packet formation based upon SyncML 1.1; an open XML-based standard adopted by W3C.

■ Two levels of sync logging for troubleshooting and reporting.

■ Column-level update logging and syncing on all tables.

■ Schema customization/definition on the Publisher – synced out chronologically to each Subscriber.

■ Last change prevails in data resolution – based on Universal Time Coordinator (UTC).

■ Each sync session is logged for later review and troubleshooting, reporting, etc.

■ Lookup → Last Sync can be either date-range based or simply the last sync session. This

Lookup will present results in a manner similar to how results are presented for our Keyword

Search functionality.

■ Administrative-style Sync Reports via ActDiag allow both configuration and preview information.

Data Logging and Tracking
The mechanism for capturing and storing data changes resides in the database itself. ACT!

creates and self-manages custom database table triggers for all insert, update, and delete
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events for optimum performance and consistency. Each ACT! database contains a series of Sync

tracking tables containing both data changes and sync definition data (metadata). Database

logging ensures several key benefits including:

■ Leverage of the client/server architecture for performance and reduced network chatter.

■ Sync changes are logged real-time and persisted in local database control tables.

■ Data logging is durable and transactionally-bound within the database – guaranteed to be

there when the user records are written.

■ Self-encapsulation of the tracking data related to the actual user data – backed-up and

restored at the same time so it’s always “in sync.”

■ Facilitates consolidated and comprehensive reporting and troubleshooting.

Additionally, each transaction is denoted with the database of origin to assist in data resolution,

as well as to provide more granular lookups and reporting. In addition to all database tables

being logged, files residing outside of the database in the Datastore (Supplemental File Location)

are also “shadow-tracked” via logging tables in the database.

Security & Permissions
Generally speaking, Administrator and Manager Role users will have the responsibility of

defining much of the Sync setup and configuration, including the creation of Sync Sets and

creating Remote databases. Standard role users will be able to perform several key tasks to

adjust content definition as required. New to ACT! Premium for Workgroups 2006, Standard

role users can be given individual permission to perform some administrative tasks while logged

into a Subscriber database as noted below:

■ Standard users and above can perform (initiate) sync from a Subscriber database.

■ Sync Set definition 

• Administrators and Managers can modify any Sync Set for any Subscriber database.

• Subscription List

• Administrators and Managers can modify any Subscription List for any Sync Set.

• Standard users can modify Subscription Lists for Sync Sets for which they are intended users. 

■ Some functionality limited on Subscriber databases

• Though the security Role permits, some features are limited or unavailable on Subscriber

databases.

• The “Remote Administrator” Permission enables the non-Administrator user to perform

tasks such as database backup and maintenance on a Subscriber database.

With regard to overall data security, the sync model itself depends upon the ACT! security

model to properly handle data access and permissions. Essentially, the Subscriber database is a

logical extension of its Publisher database – a model of equivalency. The actions a remote user

can take, as well as which data he can see, are identical to those available when the remote

user is logged into the Publisher database. 
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Administrator Database Management
Within the Manage Databases task of the Sync Panel in ACT!, Administrators can view and

manage the Subscriber databases (including Handheld Devices) as needed. Administrators have

visibility to each database’s last sync date and the days remaining until expiration. Of particular

interest is the ability to change the Status of a Subscriber database. The three possible database

statuses are:

■ Active

■ Disabled with Last Sync

■ Disabled

The Disabled with Last Sync option allows the Subscriber database to perform one last bi-

directional sync, which will set that database as Disabled on both the Subscriber database as

well as the Publisher. A Disabled Subscriber database can no longer sync with its Publisher

database. At that point, the Administrator would need to re-create the Subscriber database

from the Publisher to allow that database to begin syncing again.

It is also possible for a Remote Administrator user to “sever” the Subscriber database by

changing its status to Disabled. Once disabled, the database can become a Publisher that’s able

to create new Subscriber databases of its own.

The Database Management panel allows an Administrator to view all of the member databases

within the Sync Family. Included in the list are any handheld devices such as Palm OS or Pocket

PC that may be registered to the Publisher or any of the Subscriber databases. This enables the

Administrator to effectively manage the definition and behaviors that affect sync, and the data

remote users receive.

Technical Features and Highlights
The following is provided as a listing of technical features and specifications of the ACT!

synchronization feature:

■ SyncML v1.1

• An open, XML-based standard adopted by the W3C. Allows definition of Sync Packets

• Designed for wireless applications (low bandwidth)

• Designed to accommodate Palm OS computing

■ Transactions logged in and by the database

• Upon sync-enabling the database, triggers are generated for each table to track all inserts,

updates, and deletes

• Ensures “nothing missed” from any source

• Optimal Performance – all data stored in the database

• Approximately twenty tables to support sync (logging and metadata)

■ Column-level update logging on all tables

• By default, only changed columns are sent for updates
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• Design supports full chronological logging for all tables (could support full Audit Reporting,

etc., but could have a big impact on database footprint)

■ Multi-Level Design

• Design supports a three-level model (Publisher, child, grandchild) to accommodate

handheld devices

■ Publisher/Subscriber Model

• Connected model (no store-and-forward)

• Subscriber initiated sync (pull model)

• Subscribers have only ONE Publisher

• Subscribers allow only remote users to log in

• Remote users can manage subscriptions on either Publisher or Subscriber

• Subscriber is ALWAYS a subset of the Publisher

• Subscribers can recover from a broken or incomplete sync

• Orphaned Subscribers can become Publishers

• Database paradigm vs. user in ACT! 6.0

■ Sync Server

• .Net Remoting Framework

• Stateless and Scalable

• HTTP or TCP/IP Protocol binding

• Integrates with IIS 4.0 and above for Internet sync

• Multiple servers can be configured to run on one machine

• Can run as a Windows service (Network or Internet Sync Servers)

■ Sync Client

• .Net Remoting Framework

• Bound to the application context

• Initiates the sync process (Pull scheme)

■ Inside Firewall/LAN connection (Application or Network Sync)

• TCP/IP

• Local or Wide Area Network connection

• VPN (Virtual Private Network)

• RAS (Remote Access)

■ Outside Firewall (Internet Sync)

• Encrypted via 64-bit encryption…or

• Secure Sockets Layer (HTTPS)

■ Transport assures packet delivery and auto-recovery from dropped packets
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Preparing for Synchronization
The database Administrator can take a non-syncing database and establish it as a Publisher

database. There are seven total steps to deploy and sync the first Subscriber database:   

1. Enable sync on the subject database.

2. Start a Sync Server to accept incoming syncs for the subject Publisher database.

3. Create a Sync Set (described later in this document). This will determine/filter the “who” and

the “what” will sync.

4. Create a Remote Database. Set the options as desired in the UI panel.

5. Distribute the resulting Remote Database file (.RDB) to the targeted machine.

6. Apply that RDB file via ACT! using the File → Restore → Database menu item.

7. Verify the Sync Server connection on the Subscriber, then sync.

At this point, additional Sync Sets and/or Remote Databases can be created and deployed by

repeating steps 2 (or step 3 if you decide to use the existing Sync Set definition) thru 7 above. 

A key to sync setup is understanding and defining a Sync Set. 

Understanding and Defining a Sync Set
A Sync Set is the defined set of data in a database that is designated to synchronize to one or

more Subscriber databases. During synchronization setup at the Publisher database, the Sync

Set is defined and then assigned to a Subscriber database as that Subscriber database is being

created. The Sync Set may be used to define more than one Subscriber database. The Sync Set

dialogs and behaviors can be thought of in terms of how Group and Company query definitions

work – the Sync Set is essentially a collection of contacts. 

The contacts available to be included in the Sync Set are limited by the accessibility of those

contact records to the intended users of the Sync Set. If none of the "intended users" has

access to a specific contact, it isn't available to be part of the Sync Set. If at least one of the

"intended users" has access to a contact, it is eligible to be included in the Sync Set. A Sync Set

may be further defined through the use of a query definition that is applied to the contacts

eligible to be part of the Sync Set. In the criteria definition interface, the user has the option of

creating a new set of criteria using the query builder, or can open a saved query (.QRY file) from

a Group or Company query or an Advanced Query. Contact records may be included (beyond

the bounds of the query definition) through the use of the Subscription List.

A Sync Set may be altered by any user belonging to the Administrator or Manager Role at any

node of the sync family. However, Standard users will have limited ability to control the Sync Set

(subscription list only) from the Subscriber database node, and no ability to control it from the

Publisher database. At the Publisher database, functionality will exist to look up a Sync Set for

each individual Subscriber database.

Three major definable components of the Sync Set 
1. “Who List” (a.k.a. “Intended Users”)

■ List of intended, remote users who can log in to Subscriber database.
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■ Constrains which contacts are available to be synchronized.

■ Only those contacts accessible to at least one member of the Who list are available for

synchronization.

2. Query (optional)

■ Dynamic, criteria-based, query definition of the set of contacts to be synchronized. 

3. Subscription List

■ Additional “hand-picked” contacts to be synchronized.

■ Allows user to select additional contacts, falling outside the query definition, to be

synchronized.

Items that Always Sync:

■ Schema (from Publisher database to Subscribers).

■ Database Preferences such as Name Separators, Scheduling, etc.

■ User data including passwords, Roles, Permissions, etc.

■ Group and Company records including query definitions and extended data.

■ Database configuration and definition data lists including Custom Activities, Custom Priorities,

Custom Clearing Types, Events, Activity Series, Opportunity Stages, and Processes.

Items that the User May Choose to Sync:

■ Database Supplemental Files, including Letter Templates, report Templates, Layouts, and

saved queries specifically “belonging” to the Publisher database.

■ Attachments

• Only those documents associated with Contact records in the Sync Set, any Groups or any

Company records.

• Includes Document Tab items.

Items that Do Not Sync:

■ Personal Supplemental Files 

• Files stored in the traditional ‘Default Locations’ paths. 

• Letter templates, report templates, layouts, etc. which do not ‘belong’ to any specific database.

■ Settings and Preferences stored locally

• Including settings for Navigation bars, Toolbars, Menus, and column customization.

■ The ACT! Email database

Sync Set example:

Database contains 1,000 total contact records

■ (A) Who List

• Three users identified as intended remote users (Moe, Larry, and Curly).

• A total of 500 possible contacts are accessible to at least one of the three intended users.
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■ (B) Query

• State = “CA” 

• Reduces the 500 available candidates down to 100 that meet the criteria.

■ (C) Subscription List

• Allows users to select additional contacts, falling outside the query definition, to be

synchronized.

• 2 customers in Oregon.

• 2 vendors in Texas.

■ Total Sync Set = 104 Contacts

Subscription List

■ A list of all contacts in a Publisher database (within the Sync Family) to which a particular user

has access; includes the “core” fields including Name, Company and Phone.

■ The user may designate individual contacts to sync regardless of query definition. 

■ Allows Standard users to “data fish” – request additional contacts that do not meet the Sync

Set criteria.

■ Users can modify Subscription Lists of any Sync Set for which they appear in the “Who List.”

■ May be “Reset” to return Sync Set to the base query criteria.
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HTTP (Internet) Sync Described
The ACT! Internet Sync Server enables users to synchronize data over the Internet outside a

firewall. This means users do not necessarily need to connect into the Local Area Network (LAN)

of their workplace in order to sync their data. This differs from the other two sync server

configurations in ACT!, namely Application Sync using the ACT! application as the server, and

the Sync Service which uses an installed NT service. These configurations require users to be

logged on the network. The firewall protects the Publisher database, which can be physically

located at a protected site inside an organization’s firewall, while the remote users can sync

their data from unprotected locations using the World Wide Web (WWW). All the sync

communication is performed over standard network protocols and is protected by data

encryption algorithms to prevent eavesdropping. 

To setup HTTP Sync, the minimum requirement is a Web server; in this case Microsoft IIS

(Integrated Information Server). Currently, IIS is the only Web server that will allow HTTP sync to

occur. ACT! Premium for Workgroups includes the installer for the Web server, which configures

IIS to run Web Sync Server. The clients connect to Web Sync Servers using URLs (Uniform

Resource Locator) in the form used for conventional Web browsing. The Sync Server can listen

to incoming requests for several Publisher databases at a time, just like the standalone ACT!

sync service. The Web servers can be managed to accept incoming syncs for various Publisher

databases and these databases can be installed on different machines as the Web servers. 

A Web server listens to the incoming requests on port 80 of the machine. Traditionally,

corporate firewalls disallow any outside communications on any ports other than 80 in order to

prevent software attacks on sensitive data. However, corporate Web sites are usually hosted on

port 80 in demilitarized zones (DMZ) on the network. These zones are prone to outside attacks

but are kept safe by Web server security. ACT! Sync uses similar technology to allow syncing

outside software firewalls.

To configure the IIS Web server, the ACT! Installer will create a virtual directory and install the

necessary files in it for syncing. These files are .NET dependent and will require the .NET

Framework to be installed on the same machine as the Web server. An NT administrator

context will be needed to install and run the Web server in order to get access to shared SQL

Server instances on the network. Administrators can also log in to their machines and manage

the Web servers using Microsoft Management Console (MMC). To provide scalability and load

balancing of the Sync Servers, clustered configuration of Web servers can also be used. By

managing the Sync Server information, remote users can sync their client databases seamlessly

to Publisher databases using either a Web server or an NT service. For example, an NT service

location may be \\ACT_NTService whereas Web sync server location may be

http://www.mycompany.com/ACT_Virtual_Directory. Since the Web server always listens on

port 80 by default, users do not need to enter the port number for the Web service.

Web Sync Server is a lightweight component with limited ability to manage data on its own. 

It contains a limited UI to manage the list of the syncing Publisher databases and does not

contain any ACT! application features. To view changes made to Publisher databases, users

need to separately log in using ACT!. A Web server’s only purpose is to act as a channel

between the syncing Subscriber and Publisher database. 
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Requirements

■ ACT! Premium for Workgroups

■ Microsoft IIS 5.0 and higher

■ Microsoft Windows® 2000, 2003, XP (Pro recommended)

■ Internet connectivity

Web Server Setup

■ Port 80

■ “ActInternetSync” virtual directory

■ fport.exe/ActDiag

■ cliconfg.exe (Windows\System32)

• Alias “<computer name>\ACT7” (same as server)

• Server name “<computer name>\ACT7”

• Uncheck Dynamically determine port

• Port number “<port>” (from fport.exe or netstat)

■ Integrated Windows Authentication

Internet Sync Setup
To address the challenges of connectivity within your organization, the ACT! Sync Server can be

configured within the guidelines of an IT organization. Below are two examples of the mobile

road warrior with a Subscriber database on his notebook computer, which needs to connect to

a Sync Server back at the corporate office. To limit public exposure, don’t set the SQL database

server(s) themselves, but rather the machine(s) running the appropriate Sync Server(s).

Example 1: Internet Sync Setup – Single Firewall
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Example 2:  Internet Sync Setup – Multiple Firewalls

Advanced Troubleshooting Support
Within the ACT! product and the accompanying ActDiag utility, a number of facilities are

available for diagnostics and troubleshooting. Those items include both internal and external

logging, sync reports and a sync rebuild ability. 

Sync Logging
There are two levels of sync logging in ACT!. These logs are useful for both reporting and

troubleshooting purposes. One is stored inside the database itself and the other resides on the

machine’s hard disk.

Sync High-Level Logging

Stored in an internal database table. This will show any/all sync sessions for any/all Subscribers

when viewed on a Publisher database, or just the Subscriber itself when viewed on the

Subscriber database.

This Sync Log can be viewed via the “Tools → Synchronization Panel → View Sync Log” menu item.

Sync Low-Level Logging

Used primarily as a troubleshooting technique. By default, errors are logged here to the

resulting SYNCLOG.XML file located in the ACT! program install folder. By modifying the

application and/or Sync Server .config file, the degree and verbosity of the logging can be

increased. This is not recommended unless directed by ACT! Technical Support for problem

identification and resolution.

It is required that the applications .config file be modified when attempting to change the

logging switch values. The config file needs to be modified on both the remote client machine

for the ACT! application (Act8.exe.config) as well as the machine running the Sync Server. You

may need to modify a different .config file as noted below depending on which of the three

possible Sync Servers you are running:
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To enable Sync Logging: [<installdir>\SYNCLOG.xml]

■ Internet Sync Server – web.config

■ Network Sync Server – Act.Framework.Synchronization.Service.exe.config

■ Application Sync Server – Act8.exe.config

The Microsoft Web site contains the description and behavior of these values:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystem

diagnosticstracelevelclasstopic.asp

ActDiag
ActDiag is a diagnostic and utility tool that is installed with your ACT! installation. When

locating ActDiag within your product, it is based on your version number. Thus if you have ACT!

2005 or 7.0 it is Act7Diag and if you have ACT! 2006 or 8.0 it is Act8Diag. The following

configuration and diagnostic reports are available to run per database:

■ Sync Configuration Report

■ Sync Preview Report

■ Sync Database History Report

Additionally, a “Rebuild Sync Objects” repair utility is available if it is suspected that any

structural or metadata objects or information is incorrect. Typically, this would not need to be

run often (if at all) but it is there to assist the user in problem resolution.

Glossary of Terms
Publisher – a database from which one or more other databases are created. A Publisher

database does not initiate the sync process and is considered to be a superset of all subscribed

databases. Synonymous with Parent database.

Subscriber – a database that was created from a Publisher. A Subscriber database has only

one Parent (Publisher) database and is responsible for initiating the sync process. Synonymous

with Remote or Child database.

Parent – see Publisher.

Remote – see Subscriber.

Sync Set – a logical grouping of information that contains any contact subscription query

criteria as well as the “who list” (described here in the Glossary), essentially defining who and

what is to sync. A Sync Set can be used to define and drive the contact subscription content for

one or more Remote (Subscriber) databases.

Who List – identifies the list of database Users for whom the Contact Subscription List is

targeted in a Sync Set. In addition, this is the list of Users who are allowed to log on to a

Remote (Subscriber) database using the Sync Set.

High-Water Marks – refers to the “last success” values of a database. These values represent

the “starting point” for the next sync session. 
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Replay – in the event that the Publisher or Subscriber database has been restored from a

previous backup, the sync process will detect this. It will attempt to reset the “high water marks”

as necessary (and as available) and “replay” the transactions that have occurred since the backup.

Application Sync – the Sync Server available in both ACT! and ACT! Premium for

Workgroups. Invoked via the Tools → Sync → Accept Incoming Syncs menu item, it will process

incoming sync requests from Subscriber databases. This option is only enabled on a Sync-

enabled Publisher database. When started, it will listen for incoming sync requests for the

current database only.

Network Sync Service – available with ACT! Premium for Workgroups only. Installed separately,

it runs as a service class process. It contains a UI form that allows the user to “register” one or

more SQL Server machines and databases which the server will listen on behalf of. 

Internet Sync Service – available with ACT! Premium for Workgroups only. Installed

separately, it runs as a service class process. It uses public port 80 for incoming sync

requests/traffic. It allows the user to “register” one or more SQL Server machines and databases

that the server will listen on behalf of.

Evil Twin – a second copy or deployment of a Remote database (.RDB file). A Subscriber

database is considered unique. Once created, an RDB file could be distributed to multiple

machines and restored, however, ONLY the first Subscriber database to successfully sync with

the Publisher will establish the “contract” between the Publisher database and that Subscriber

database name. Any subsequent attempts to sync that RDB file deployed onto a different

machine are rejected by the Publisher and considered to be an “evil twin.” 

Remote Administrator – new to ACT! Premium for Workgroups 2006 (not available in ACT!

2006). A database Administrator, via the “Manage Users” panel in ACT!, can assign the

“Remote Administration” permission to a Standard user. This will enable that Standard user to

perform administrative tasks, such as database maintenance and backup, when logged in to a

Subscriber database.

Subscription List – a by-product of the Sync Set. Contains a list of contacts available to the

users of a Sync Set (the “who list”), identifying subscribed contacts and non-subscribed

contacts. Contacts are subscribed either automatically (via query) or manually (via user

selection). Any non-subscribed contacts can be manually-subscribed by the user – such action

will cause the contact and all extended data to be retrieved upon the next sync session.

Sync Log – a database table containing sync-relevant events. These events include Sync Set

and Subscriber Database creation and change, as well as the steps within each sync session and

resulting record counts and statistics. This Sync Log is viewable from the Sync Panel.

References & Related Links
Sage has created and maintains a Knowledge Center Web site that addresses many known

issues regarding ACT!. At present there are over twenty sync-related articles that can be

referenced to a specific feature of the product.
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The ACT! Knowledge Center can be located at:

http://www.act.com/support/technicalsupport/knowledgebase/

To search relevant articles, provide the “ACT! by Sage 2006” Product and “Sync” for the 

Search Text:

19



8800 North Gainey Center Drive, Suite 200

Scottsdale, Arizona 85258

www.act.com

©2005 Sage Software SB, Inc. and TMurgent Technologies. All rights reserved. The Sage Software logo and ACT! are registered trademarks
or trademarks of Sage Software, SB Inc. or its affiliated entities. All other trademarks are the property of their respective owners. 1105


